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University of Cambridge Computing Service 

Zotero: a free, open-source reference management program 

 
Rosemary Rodd          August 6, 2020 

If you have previously set up a Zotero account and registered your details online, I 
recommend that you do not use that account for the course because of the risk of over-writing 
or deleting your existing references. Use the program locally only for the purposes of the 
course. 

1.  Installing Zotero 

The current version of Zotero uses add-ons to connect it to Word or Libre Office (in order to add 

citations to your documents) and to a web browser (in order to collect citations). 

 

Use the search tool to locate the Zotero application and double-click it to start. 
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1. Click Next to install the plugins then Finish (ignore any messages that say installation has failed). 

2. Start the Chrome web browser and go to https://www.zotero.org/  

3. Click the Download Now button, then Install Chrome Connector 

4. Click Add to Chrome, then Add extension to allow the connector extension to install 

 

 

5. Use search to start up Adobe Acrobat Reader so that you will be able to view downloaded 

PDF files. Leave Acrobat running and return to the Zotero application. 

https://www.zotero.org/
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2.  Set a directory to store your reference library 

By default, Zotero stores your references on the PC's C: drive. On a personal machine this would 
usually be what you would want, but if you plan to work on the MCS machines you need to set it up 
so that they are stored in your identifier's MCS file space. 

1. Click the Edit menu and choose Preferences. 

2. Click “Advanced” then the “Files and Folders” tab. 

3. The second option on the tab is the Data Directory Location. Click the radio button beside 
“custom” to let you set a directory of your choice. 

4. Click “Choose”. 

5. Click “New folder” to create a folder to store the library. Give it a meaningful name (e.g. Zotero 
Library and click select folder). Zotero will warn that it’s empty, so click to accept this as we’ve 
not added any contents yet. 

6. Quit Zotero and restart it. 

Note: You can only have ONE personal library (although there are options for collaborating 
academics to create multiple shared group libraries). You can sub-divide your personal library into 
“collections” covering different topics, but don’t attempt to create multiple libraries by setting up 
several alternative Zotero directories as you are very likely to end up accidentally over-writing them. 

3.  Set up synchronisation: “syncing” [omit if you already use Zotero] 

1. In Zotero, select Edit > Preferences. 

2. Click the Sync icon then Create Account and register your details to set up an online 

account. 

3. You don't need to check your email before entering your account username and password 

in Zotero's Sync preferences. 

4. Notice the check boxes which control Zotero’s sync options. You can choose to have Zotero 
synchronise files automatically or only when you click the sync button in the menu bar. You 
can also control whether Zotero synchronises just your references and annotations, or 
whether it also copies files, such as full-text article PDFs, which you’ve attached to the 
references. 
If you choose to include full-text file syncing, you will probably exceed your free storage 
allowance on Zotero’s servers. If this happens, you can either pay for increased space, or 
make alternative arrangements. 

Please read the important notes about the difference between syncing and backing up at 
the end of this document. 

4. Set Zotero’s preferences 

1. Click the “General” tab (in Preferences). 

2. Make sure the box beside “automatically attach associated PDFs…” is checked. 
This setting will cause Zotero to download and attach associated PDFs, and other full-text 
sources belonging to an online reference, if it can. This can save you time compared with 
manual location, but will make your database rather large and you may want to turn it off 
again if you prefer to save only a selected number of full text papers. 

This works better with some online sources than others and sometimes you will need to do a 
manual search to find the full text. Be aware that some journals have Terms and Conditions which 
forbid automatic bulk download of search results: for example the American Physical Society 
doesn't even permit automatic download of journal abstracts. 

Problems are unlikely to arise when you are downloading from resources which search multiple 
journal databases (such as Web of Science or Scopus) but it's advisable to check the Terms and 
Conditions if you are running a search on a journal's own website. 

3. Uncheck “Automatically take snapshots when creating items from web pages.”  
You can turn this on again if you work off-line a lot and want saved web pages to be 
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available, or if you want to keep a record of the current state of a page in case it alters. 
However, if you save a lot of web pages with small graphics this can eat up lots of space on 
your hard drive and clutter your folders. 

4. Click the “Advanced” tab, then General (in the tabs below the top buttons) 

5. Click the button “Search for Resolvers”. 

6. When Zotero responds “1 Resolver found” use the pull down menu beside the button to 
select “Cambridge University Library”. 

7. Click the “Update Now” button beside “Automatically check for updated translators” to get 
the latest version of the interpreters which identify references on the web. (May not work on 
the MCS machines) 

8. Click “OK” to close the preferences. 

5.  Search for some references online 

1. In the Chrome browser, go to scholar.google.co.uk and do a search (you may be asked to 
complete a “Captcha” to prove you're not a robot). 

2. Enter something in the search box and click the search icon. 

3. A small folder icon will appear at the top right of the menu bar. Click it once. 

4. Another window will open, listing all the search results on the current page with a check-box 
beside each one. 

5. Click “Select all”, then “OK” to download all of that page's results into Zotero. 

6. Now look at Zotero again. You should see that the selections have been downloaded into 
the library of references. 

7. Try the effect of "clicking through" some of the links on the page of Scholar results and then 
clicking the Zotero icon for the individual papers. You will probably find that this causes the 
full text PDF of the article to be saved to Zotero as well as the reference. 

Note that automatic download by clicking the menu bar icon depends on Zotero being able to interpret 
reference data found on the page. You will almost certainly find at some point that upgrades to 
databases you use mean they are no longer able to be understood by Zotero. When this happens, 
the solution is to post a request for help to the Zotero online forum for troubleshooting 
http://forums.zotero.org/categories/ and select troubleshooting. 

6. Create a “Collection” to sub-divide your library 

1. Click the icon on the far left of the Zotero menu bar (looks like a small folder with a green 
plus) 

2. When a dialogue box asks you to name the new collection enter “Shakespeare”  
3. You’ll see an empty folder has been created and selected. 

It’s possible for a single reference to be a member of several different collections - think of them as 
"views" rather than containers. 

7. Download some references into this new collection 

1. Go to www.jstor.org (in the main browser window) and do a search for Shakespeare Earl 
Oxford. 

2. Click on one of the Download PDF buttons and accept the Terms and Conditions, then return to 
your search results. 

3. Click the Zotero folder icon in the address bar and select all or some of the items to 
download. Click OK to start the download. 

4. Check the Zotero application again. 
5. Your new downloads have been listed in the Shakespeare collection. 

6. Zotero attempts to download the full text of articles and attach these to the relevant 
references. You should find that downloads from JSTOR usually do include the full text.  

If you get an error message, try downloading fewer of the references at a time. 

Collections are simply sub-sets of your Zotero library: click "My Library" to view all your references. 

http://forums.zotero.org/categories/
http://www.jstor.org/
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8.  Give your full text PDF files more meaningful names 

1. Click the arrow on the left of a few of your downloaded references. 
2. You should see that some references have attached PDF files. 
3. Right click on one of these PDFs and choose “Rename file from Parent Metadata” 
4. Zotero will change the name to something meaningful based on author and title.  

 
Change back to MyLibrary from the collection view when you’ve finished. 

9.  Retrieve some references from the UL’s Catalogue 

1. In your browser, go to http://www.lib.cam.ac.uk/  
2. Now do a search using iDiscover. 
3. You should see the small folder icon appear at the top right of the browser address bar.  
4. Select some or all of the references to download and click OK to save them into your 

library. 

10.  Locating the full text of a reference manually 

1. Most of the JSTOR references will have the full text PDF attached automatically, but many 
of the Scholar references will be a citation only, with a link back to the original entry in the 
database. 

2. Zotero can help you to find the full text of any reference in your library. To try this, select a 
reference without a PDF (must be a journal article, not a book) and click the “ locate” button 
(small straight arrow icon just above the Info tab) and choose “Library lookup”. If the journal 
is available online, you'll see the main browser window go to the library and offer a clickable 
link to take you to the full text. 

3. Try opening the full text of a journal article and downloading it in PDF format. (May not work 
well on the MCS) 

4. Save the pdf file to your computer in Documents. 

11.  Attach a downloaded file to a reference in your library 

1. Select the article in the Zotero library by clicking on it once. 

2. Look at the menu bar at the top of the Zotero pane. Roughly at the centre, you'll see a 
paperclip icon. 

3. Click the paper clip to pop down its menu and select “attach stored copy of file”. 

4. Browse to your documents folder and select the PDF that you just saved. Click Open. 

5. Now, if you click the little plus sign or arrow beside the reference in Zotero, you will see that 
there is a pdf icon attached to the reference data. 

Your downloaded PDF has been copied to the Zotero directory which you set up. You can take a 
look at the contents of this directory, but the individual sub-directories are given rather unhelpful 
names, and it's usually best just to back up the whole of it and access the individual stored files via 
Zotero itself. 

As an alternative, you can often import the PDF directly into Zotero by selecting “Save to 
Zotero/Retrieve metadata for PDF” at the download stage.  This will create a duplicate reference and 
you will need to delete the original. 

12.  Add a free-text note to your references 

1. Click the Notes tab on the right-hand side of the reference, then the Add button to open a 
new sub-window where you can type in your own notes. 

2. Click the Edit in a separate window button to open the Notes window as a full-sized editing 
area. You can compose as much text as you want, using the toolbar to format it as you would 
in an ordinary word-processing package. 

Notes can be copied and pasted into your final document and text styles, such as bold and italic will 
be preserved. 

http://www.lib.cam.ac.uk/
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WARNING: Unless you have set up Zotero to sync online, your data is stored in the Zotero folder on 
your local machine. If this is not backed up and the machine crashes or is stolen you could lose the 
lot! I recommend that you make a copy of your Zotero directory on a memory stick at the end of each 
work session or set up a system to make daily backups of your complete hard drive. If you write a 
lot of notes in Zotero this is particularly important. 

13.  Tag your references with keywords of your choice 

1. Click the Tags tab on the right pane of Zotero. 

2. Click the add button to insert some keywords. Tags can be made up of more than one word, 
but each one should be on a separate line (get a new line by clicking the add button a second 
time or simply hitting the Return key). 

As you tag references the new terms are added to the clickable list of tags in the left hand pane (you 
may need to make this visible by clicking the dot at the centre of the bottom of this column if it has 
been closed). 

If your downloaded references included keywords these may already have been added to the tags 
field if Zotero was able to identify them. 

14.  Mark related references in your library 

1. Click the Related tab on the right of the reference, then the add button. 

2. A list of references in your library will be displayed 

3. Type one of your keywords into the search box and click OK 

4. If any of the other references have the word anywhere in their entry they will be displayed. If 
none of them is left, try another keyword until you find something that works. 

5. Select the displayed references and click OK to associate them all with your original 
reference. 

6. Click one of the references that you've just associated with the original one and notice that 
the association is reciprocal: the first reference is now listed as related to the second. 

7. If you want to, you can associate references without searching for particular words: just click 
Related > add and select them from the complete list. 

The Notes can have tags and related references associated with them independently of the 
reference itself. This can be useful if you want to make a distinction between keywords relating to 
your own thoughts about the paper and the author's keywords. 

15.  Create a reference item manually 

The easiest way to collect references is to import them from online sources. For older material this 
may not be possible. In these cases you can create new references and type the information in 
manually. 

Zotero can only format your new item correctly if you pick the right type of document (for example 
book, book section [chapter], or journal article) as different kinds of document have to be set out 
differently in your bibliography. In this example we’ll create a reference for the Handbook of Medieval 
Exchange, written by Peter Spufford and published in London by the Offices of the Royal Historical 
Society in 1986 as number 13 in their series, Royal Historical Society Guides and Handbooks.  

1. Click the green plus icon near the centre of the Zotero menu bar to drop down a list of possible 
types of reference. The handbook is a Book, so select that. 

2. You’ll see a new item appear in the right-most section of the Zotero pane, and a 
corresponding blank item in the library listing. 

3. Click the title field and type in “Handbook of Medieval Exchange” (without the quotes). Press 
tab to skip to the next field. 

4. Enter the Author’s name (tab to get from the lastname slot to firstname). 

5. Continue filling in the slots for which you have information. Don’t worry if some have to be 
left blank: Zotero provides fields for most eventualities and not every reference will use them 
all. 
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16.  Using Zotero in conjunction with a word-processing system 

Zotero can be used as a citation manager with MS Word, Open Office and LaTeX. 

In this practical you’ll only use the plug-in for MS Word, but the basic principle is the same for Open 
Office. 

(If you need to use LaTeX, the system for inserting citations is rather different and is described in 
exercise 21.) 

17.  Adding a formatted bibliography to any document 

If all you need is a formatted list of the references contained in your library, this can very easily be 
achieved by drag and drop. 

1. From the Zotero menu select Preferences 

2. Click the Export button. 

3. Select a style by pulling down the default output menu. 

4. By default, you cannot copy more than 50 references to a document by drag and drop. If you 
wish to copy more than this, edit the figure in the box labelled “Disable Quick Copy when 
dragging more than [50] items. 

5. Close Preferences. 

6. Open a blank document (any word processor), and switch to the tiled view so that you can 
see multiple windows at the same time. 

7. Select all the references in your main library window and drag them across to the open 
document. (You may need to adjust the size of the two windows so that both are visible 
simultaneously).  
NOTE – this may not work correctly if any of the references have their attachments 
displayed by clicking on the arrow icon. 

8. The references will appear in the document sorted into alphabetical order by author and laid 
out according to your chosen style. You may find that some still need some manual 
adjustment — for example where older reference titles are in all caps. 

If you entered the Medieval Exchange reference correctly in the previous exercise you should 
find that it has been laid out with correct punctuation and italicisation etc. 

Chicago: 

Peter Spufford, Handbook of Medieval Exchange, Royal Historical Society Guides & Hand-
books 13 (London: Offices of the Royal Historical Society, 1986).   

Nature: 

1.   Spufford, P. Handbook of Medieval Exchange. (Offices of the Royal Historical Society: London, 

1986).   
 

You can also export your bibliography as an RTF (Rich Text Format) file, which can be opened by 
Word or Open Office. 

1. Select the references you want to export and control/click [Mac] or right-click [Windows] on 
the selected items. 

2. Choose Create Bibliography from Selected Items… from the pop up menu which appears. 

3. Select the output style you require and check Save as RTF. 

4. Give the exported file a suitable name and save it. Make sure you click the Documents link 
on the left to  ensure that you save into your Documents folder and not into the Zotero Library 
folder. 

18. Creating a bibliography by inserting citations in a document 

1. Go to open Microsoft Word and create a new blank document. 
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2. (If you see a warning message (yellow bar) that macros have been disabled, click Enable 

Content,  to permit the Zotero add-in to work.) 

3. Click the Zotero tab. 

 

1. To insert a new citation in your document, position your cursor at the point where you want 
it, then click Add/Edit citation. 

 

2. A dialogue box opens asking you to select a citation style for the document. Choose the 
style you prefer and click OK. This opens the Zotero reference search “bubble” 

 

3. You can search for a reference by typing in the Zotero “bubble 

4. Choose a citation from the list of found items and hit return to insert it. 

5. You can search again before hitting return if you want to insert multiple citations at that 
point. Simply build up the group of references in the “bubble” then hit return to insert them.  

6. If you prefer to browse your whole library, pull down “classic view” from the tiny menu 
beside the Z. 

 

Zotero citations 
pull-down menu 
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7. Wait for your Zotero library to open in a new window. If you need to insert more than one 
reference, click the button “Multiple Sources” [for something like (Jones, 1956; Smith, 
2009)]. 

8. Select a reference from the window. At this stage you can reference particular pages or add 
a prefix or suffix (such as “see ...”). 

 

9. Click OK. 

10. Zotero will either insert a citation in the body of the text or create a footnote and insert the 
citation there (depending on the style you chose). Notice how the sample citation below 
specifies the two specific pages of the nine-page article which were typed in when the 
reference was selected. 

 

11. You can make changes to the citation, such as adding prefix/suffix and references to pages 
after you have added it to your document. Simply put the cursor on the citation and click 
Add/Edit citation. This will return you to the add/edit dialogue box. Click the citation in the 
“bubble” to make changes using the contextual menu that pops up (e.g. add a page 
number), then hit return to commit them. 

12. Once you have some citations in your document, you can tell Zotero to create a 
bibliography of the inserted references. Type in a suitable heading (such as “References” 
and position the cursor after it. Then click Add/edit Bibliography to create your bibliography. 
Once inserted, it will update as you add more citations to the document. 

13. If you decide you want to apply a different reference style to the document, you can select 
another style by clicking the Document Preferences icon. Zotero will instantly reformat your 
references. 

Warning about Zotero on the Managed Clusters: these machines have Zotero, Mendeley and 
EndNote installed and this can cause problems with citations in Word documents because all three 
programs will potentially attempt to edit them. If you RIGHT-CLICK on a Zotero citation an EndNote 
edit menu may open but will not actually be able to modify the citation and a fatal error may occur.  

19.  Modifying Zotero Styles 

Zotero styles are written in an XML based language called Citation Style Language (CSL). At present 
there is no GUI interface to edit them, so if you cannot find a suitable style in the standard formats 
or in the Zotero Style Repository (http://www.zotero.org/styles), you will need to get to grips with 
writing CSL direct. This is not for the faint-hearted or non-technically-minded and is beyond the scope 
of this course. If you want to get some idea of what is involved, there are some online tutorials at: 

https://www.zotero.org/support/dev/citation_styles 

http://docs.citationstyles.org/en/stable/primer.html   

http://citationstyles.org/  

http://www.zotero.org/styles
https://www.zotero.org/support/dev/citation_styles
http://docs.citationstyles.org/en/stable/primer.html
http://citationstyles.org/
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20.  Using Zotero with LaTeX (can be ignored if you don't use LaTeX) 

BibTeX is a specialised bibliographic markup system to enable advanced reference processing with 
the LaTeX wordprocessing system. If you are required to produce your thesis in LaTeX then Zotero 
is a good system to use to manage your references. 

If you don’t need LaTeX, you can ignore the rest of this section. 

1. Click File > Export. Choose BibTeX as the output format and save the file with a suitable one-
word name. 

2. By default Zotero creates a file with the utf8 encoding, which some LaTeX installations don't 
handle well. To preserve the special characters such as “–” it's best to open the file in your 
text editor and use global search and replace to change — to --- and so on. Use the Save As 
command to change the encoding to Latin 1. 

3. The exported file contains your references laid out in BibTeX format as shown below. It’s in 
plain text, but has the extension .bib 

@article{johnson_jr._calculation_1958, 

 title = {Calculation of nuclear magnetic resonance spectra of aromatic 

 hydrocarbons}, 

 volume = {29}, 

 journal = {The Journal of Chemical Physics}, 

 author = {C. E. {Johnson, Jr.} and F. A. Bovey}, 

 year = {1958}, 

 pages = {1012} 

}, 

To insert a citation in your main document you need to complete the following steps: 

1. Copy the reference key generated by Zotero from the item's author, title and year. In the 
example above this is johnson_jr._calculation_1958 

2. Paste the key into your document at the point where you want the citation to appear and 
enclose it in curly brackets. 

3. Immediately before the citation type \cite 

4. You need to end the file with commands to set a bibliography style and insert a bibliography 
using a named BibTeX file as follows: 

\bibliographystyle{newapa} 

\bibliography{chem} 

\end{document} 

The calculation citation above will print as “(Johnson & Bovey, 1958)” if it is formatted with the apa 
bibliography style, which is a form of author-date.  If you get unexpected error messages, check 
carefully that you have no spelling errors in the commands. It is very easy to make slight mistakes 
in copying and pasting long commands like “bibliographystyle”'. 

If you want to print all the items in your BibTeX file without citing them in the body text, you need to 
put the \nocite{*} command immediately before the bibliography style command. 

 

A dummy file such as : 

\documentclass{amsart} 
\begin{document} 
\nocite{*} 
\bibliographystyle{amsplain} 
\bibliography{mybibliography} 
\end{document} 
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can be used to print out the whole BibTeX file with no preceeding text. 

21.  Downloading single references 

1. In your browser, go to www.scopus.com and do a search. 

2. The small folder icon will appear, but selecting references to download will often not 
succeed. 

3. Click through one of the links to go to the source reference. 

4. The folder icon will be replaced by an icon which indicates what type of document you've 
reached; there are different icons for various possible types and you will also see them 
displayed in your library (for example you should see icons representing books and 
articles). 

5. Click the icon to download its reference into your library. 
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22.  Setting up Zotero and the plugins on your own machine 

1. Go to  www.zotero.org site in your browser and download the program from there. 

2. Open Zotero. 

3. Go to Preferences and click the Cite button. Then click the word processors tab to install the 
correct plug-in for your preferred word processor program. 

4. To install the browser connector go to: https://www.zotero.org/download/ Zotero will attempt 
to offer you the correct connector for the browser you are currently using (there are connectors 
for Chrome, Safari, Firefox and Opera but not for Edge or IE). 

 

23.  The distinction between syncing and backing up 

 

You need to be clear that syncing is NOT A SUBSTITUTE FOR KEEPING BACKUPS! 

http://www.zotero.org/
https://www.zotero.org/download/
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The sync option can be very useful, but you need to be absolutely clear that it is simply a way of 
storing what you are currently doing in two places (the local computer and Zotero’s servers) so that 
you can move to a different machine, sync again, and carry on working. 

If you accidentally delete something you didn’t mean to, or corrupt your data in some way, the 
problematic changes will overwrite the remote copy. 

It’s possible for Zotero to become confused about which is the most up-to-date copy of your data 
and over-write a newer version with an older one, and it’s also possible to confuse the program if 
you accidentally register yourself with two different usernames, or if you and another person use a 
shared computer without separate user accounts. 

Zotero will normally attempt to warn you if the local and remote data appears likely to belong to two 
different accounts, but this then means you will have to identify which should be the master copy 
and for peace of mind it is very desirable to have a completely separate copy in case of accidents. 

I would strongly advise you to keep manual backups on media such as memory sticks, or CDs in 
addition to using synching, or arrange a system to back up your entire hard disk automatically. 

Make a backup after each day’s work, and keep at least the current and previous day’s backups so 
that you can revert to a known good copy if something goes wrong. Keep the backup media 
separate from your laptop so that you will have them if the laptop itself is stolen. 

This is very easy to do by dragging and dropping or copy/pasting the entire Zotero data directory to 
the backup media — and is another reason why you should make sure it is in a location that you 
can easily find. 

It is is advisable to read the advice on troubleshooting synching: 
http://www.zotero.org/support/kb/sync_reset_options 

Make sure you understand which way your files will be copied so that there is no danger of over-
writing your latest version. 

You also need to bear in mind that the online data may be stored on a machine outside the EU, so 
if any of it could be classed as “personal” you might be in breach of the Data Protection Act.  

This is unlikely to be a problem if your library simply consists of published references but it might 
be an issue if you have any personal communications, particularly if these are not of a purely 
academic nature. For example, reference to a public lecture which has never been published 
would be a personal communication but the lecturer is unlikely to object to being given credit for 
the ideas in it. However, reference to a private interview about someone's experiences of receiving 
hospital treatment would be sensitive personal data. 

There’s more advice about backing up and restoring Zotero data at: 

http://www.zotero.org/support/zotero_data#backing_up_your_zotero_library 

If you look inside the Zotero folder you'll see that there is a folder called “Storage” and a file called 
zotero.sqlite (as well as some other files and folders). 

If you choose to sync your database but not the attachments it is the sqlite file which will be copied 
up. It contains just the citation data, not the full text files. When zotero is working, the sqlite 
database is being constantly updated and this is the reason why it is dangerous to try putting your 
Zotero folder in Dropbox (or Google Drive or any similar “cloud” external storage). If something 
goes wrong and Zotero and Dropbox try to modify the file simultaneously it can corrupt the file so it 
doesn't work at all! 

Zotero's own sync mechanism is safe because sync is being initiated by the Zotero program itself 
(so is guaranteed not to happen when the program is trying to write back a file) while DropBox 
relies on detecting when a file has changed. 

There's some information about trying to get round this issue at 

http://zotpad.uservoice.com/knowledgebase/articles/103395-what-is-a-symbolic-link-and-why-
should-i-use-one-w  

If you don't understand it then take the safe options and either pay for extra Zotero server space or 
make periodic manual backups that you can revert to if your local machine crashes. 

http://www.zotero.org/support/kb/sync_reset_options
http://www.zotero.org/support/zotero_data
http://zotpad.uservoice.com/knowledgebase/articles/103395-what-is-a-symbolic-link-and-why-should-i-use-one-w
http://zotpad.uservoice.com/knowledgebase/articles/103395-what-is-a-symbolic-link-and-why-should-i-use-one-w
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24.  Further help 

If you want more individual help, email: servicedesk@uis.cam.ac.uk 

If you are unsure which electronic reference databases are most relevant to your work, the UL’s web 
pages are the best place to start:  http://www.lib.cam.ac.uk/eresources 

For help with deciding the correct information to include in references it's worth taking a look at the 
Cite Them Right website http://www.citethemrightonline.com/Home 

25.  Legal References 

Legal referencing rules are more complex than those for any other subject, and you may well find 
that no software program is capable of doing what is required without some degree of final manual 
editing. 

There's a helpful interactive tutorial for OSCOLA (Oxford Standard for Citation of Legal Authorities) 
at https://xerte.cardiff.ac.uk/play_6716 

You may like to investigate Juris-M, which is a variant of Zotero designed for better handling of 

legal references. You can download the program from https://juris-m.github.io/  
 
There are several issues to consider if you need to use legal referencing: 

• Legal sources are frequently not “clean” in terms of punctuation and/or tagging in the way 
that scientific ones generally are. This may mean that there is no way to download and 
import from some legal databases or that references can be imported but have extraneous 
punctuation that you need to correct manually. 

• Juris-M is the work of one enthusiast so there is no guarantee it would continue to be 
available if something happened to him. However Juris-M and Zotero are very compatible 
so it should be possible to convert your Juris-M library back to Zotero if this did happen. 

• Juris-M was originally designed to solve the particularly difficult problems of legal scholars 
in the US and UK legal referencing is not quite as complex. 

 

http://www.lib.cam.ac.uk/eresources
http://www.citethemrightonline.com/Home
https://juris-m.github.io/

	University of Cambridge Computing Service
	Zotero: a free, open-source reference management program
	If you have previously set up a Zotero account and registered your details online, I recommend that you do not use that account for the course because of the risk of over-writing or deleting your existing references. Use the program locally only for t...
	1.  Installing Zotero
	2.  Set a directory to store your reference library
	3.  Set up synchronisation: “syncing” [omit if you already use Zotero]
	4. Set Zotero’s preferences
	5.  Search for some references online
	6. Create a “Collection” to sub-divide your library
	7. Download some references into this new collection
	8.  Give your full text PDF files more meaningful names
	9.  Retrieve some references from the UL’s Catalogue
	10.  Locating the full text of a reference manually
	11.  Attach a downloaded file to a reference in your library
	12.  Add a free-text note to your references
	13.  Tag your references with keywords of your choice
	14.  Mark related references in your library
	15.  Create a reference item manually
	16.  Using Zotero in conjunction with a word-processing system
	17.  Adding a formatted bibliography to any document
	18. Creating a bibliography by inserting citations in a document
	19.  Modifying Zotero Styles
	20.  Using Zotero with LaTeX (can be ignored if you don't use LaTeX)
	21.  Downloading single references
	22.  Setting up Zotero and the plugins on your own machine
	23.  The distinction between syncing and backing up
	24.  Further help
	25.  Legal References


